CAREWare 6
June 2019

Quick Start Guide #8

Advanced Custom Reports

CAREWare Quick Start Guides will walk you through the basics of setting up, managing, and using the
main CAREWare functions. It is intended for non-technical users who need to get basic information in and
out of CAREWare.

PLEASE NOTE: The client data used in these manuals is purely fictional.
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First Things First
Getting Started

¢ You must have the appropriate user privileges to run reports.

e You should have a number of clients entered in the system so you can see how your
reports will look.

e Please see Quick Start guide #7, “Basic Custom Reports,” before moving on to this
guide. This manual assumes basic knowledge on creating basic custom reports.

Creating an advanced custom report

As you get comfortable with custom reports, you can create more complex reports. We will start
by creating a “client list” report from the Central Administration domain.

1. Log into CAREWare. For more details on how to do so, please refer to Quick Start Guide
#1. Choose Central Administration.

Submit Cancel

Login
Search:

Provider Locked

| Central Administration |

Kevin's Clinic

Ryan White AIDS Care and Treatment Clinic
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2. Select Reports from the Main Menu and then Custom Reports from the Menu of Links.

@ . CAREWare Reports
Customize

Find Clent ®CAREWare Reports
Rapid Entry
My Settings

HRSA Reports RSR and ADR

System Messages Custom Reports Run or manage custom reports

System Information I
Administrative Options

Switch Providers Performance Measures Run or Manage Performance Measures
Log Off

Client Data Reports Run reports on client information

3. The Custom Reports menu will appear. Select Manage/Run Custom Reports.

CAREWare Reports > Custom Reports
Back

®Custom Reports

l Manage/Run Custom Reports Run or manage custom reports
Copy Custom Reports Copy custom reports between providers
Export Custom Reports Export custom report definitions to a portable xml file

Import Custom Reports from an

xml file Import custom report definitions from a portable xml file
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4. Select Add from the Action bar.

CAREWare Reports > Custom Reports > Manage Run Custom Reports
Manage Run Delete Make Read Only Back Help Print or Export

Manage/Run Custom Reports

Search:

Name CrossTab Report Type Description Read Only Date Created
CHCACT 10 Medical Transporta Service 7/20/2016 7:32 AM
CHCACT 11 Persons that receiv Service 7/20/2016 7:32 AM
CHCACTAZ2 # of Positive HIV Te Service 7/20/2016 7:32 AM

5. Enter in the following information (as applicable) and click Save.

Report Name

Report Type

Is Crosstab (checkbox)

Description (optional)

Use Totals (checkbox — will automatically sum total fields in the report)
Header/Footer Format (optional)

CAREWare Reports > Custom Reports = Manage Run Custom Reports = Add

Add

Setup Details
Report Name:
Report Type:
Is Crosstab: ||

Description:

Use Totals: [J
Header/Footer Format
Font Name: |Arial
Bold: [J
Italic:  [J
Underline: [|
Font Size: |10
Color: |Black
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6. Once you click save, you'll be directed to the new Custom Report menu (in this example,
Client List is the name of our custom report). Select Field Selection.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List
Back

@Client List

Start Date : 06/11/2018, End Date : 06/11/2019, Clients with services, Report Display as :

Bunigepol Open in New Window, Most medical services in date span
Report Layout Client List, Demographics
| Field Selection | No fields selected
Report Filter Report Filter is empty

7. Click Add.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List > Field Selection
Manage Move Up Move Down Delete Templates Back Print or Export

Field Selection

Search: ‘

Field Name Column Header Column Width (in) Totals Sort Sort Priority
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8. Select Field Name, Name. Note we have entered “name” in the Search box to narrow the
list of available field names. Click Use Field.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List > Field Selection > Add

Back Print or Export
Report Fields

Name

Field Name Keywords
First Name Demographics
Last Name Demographics

Last Service In Con Demographics
Middle Name Demographics

Name Demographics

Previous Field Nar Description

First Name

Last Name

Last Service In Con Returns name of se

Middle Name

Name

Physician name Demographics

Phys. Name
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9. Select Sort, “Ascending” in order to display the Field Name values (in this example, client
names) alphabetically in the report. Use default values for Header Column Format and
Data Column Format. Click Save.

CAREWare Reports > Custom Reports > Manage Run Custom Reports = Client List = Field Selection > Add > Use Field

Back

Use Field

Select Field: |[Mame

Column Header: |Name

Sort :

Sort Priority: |1 |

Header Column Format

Column Width: |1.44 | inches

Column Header Font Name: |F'.ria| B

Bold:
Italic:
Underline:
Font Size:

Font Color: |Blacl-<

i O oo

Data Column Format

Font Name: |F'.ria| B

Bold:

Italic:

Underline:

Font Size:

i O oo

Font Color: |Blacl-<

LN
a‘

Field Justification: |Left

10. Repeat the same steps to add and save Field Names: DOB, Gender, and Race/Ethnicity.
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Use default settings for these additional report fields and do not sort. When finished, the Field
Selection should look like this:

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List> Field Selection
Manage Add MoveUp MoveDown Delete Templates Print or Export

Field Selection

Search:‘ ‘

Field Name Column Header Column Width (in) Totals Sort Sort Priority Status
Name Name 1.44 Ascending 1 Complete
DOB DOB 0.68 0 Complete
Gender Gender 0.88 0 Complete
Race/Ethnicity Race/Ethnicity 1.44 0 Complete

11. Click Back (see previous screenshot) and then select Run Report.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List
Back

@Client List

RiifRaEsH Start Date : 06/11/2018, End Date : 06/11/2019, Clients with services, Report Display as :
P Open in New Window, Most medical services in date span
Report Layout Client List, Demographics
Field Selection Name, DOB, Gender, Race/Ethnicity

Report Filter Report Filter is empty
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12. Click Edit (where Save is in the screenshot below) to change the parameters/date span as
desired. Click Save. We have selected checkboxes for:
e Show Clients with Service only
e Show Specifications
e Sum Numeric Fields

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List > Run Report > Edit

Save | Cancel

Run Report

Parameters

Date From: |1/1/2019

i3 i3
ii‘r:] i

Date Through: |12/31/2019
Clinical Review Year: 2019
Output Display: |Open in New Window ﬂ

Show New Clients only: |

Show Clients with Service only: ¥
Show Specifications:

Sum Numeric Fields: ¥

Primary Provider: Most medical services in date span ﬂ

Group By Provider: |

Selected Providers: |Provider Selection is required to run custom reports
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13. Select Selected Providers.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List> Run Report
Edit | Selected Providers | Run Report Back

Run Report

Parameters
Date From: |1/1/2019 &
Date Through: | 12/31/2019 "

Clinical Review Year: (2019

Output Display: |Open in New Window |

Show New Clients only:
Show Clients with Service only: ¥
Show Specifications: ¥

Sum Numeric Fields:

Primary Provider: |Most medical services in date span

Group By Provider:

Selected Providers: |Provider Selection is required to run custom reports

14. Select the desired providers using the checkbox. Once complete, click Save.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List > Run Report > Selected Providers

Select All  Clear Selection  Cancel  Print or Export
Selected Providers

Search: |Clir|ic

Select Provider Name

2] Kevin's Clinic

72 Ryan White AIDS Care and Treatment Clinic
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15. Select Run Report. Click View Client List in the Report generation complete box (not

pictured).

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List> Run Report

Edit Selected Providers §| Run Reportj Back

Run Report

Date From

Date Through

Clinical Review Year:

OQutput Display

Parameters
- 11112019 -
. [1213172019 -

2019

g |Open in New Window |

Show New Clients enly:

Show Clients with Service only:
Show Specifications:
Sum Numeric Fields:

Primary Provider:

v

v

+

Most medical services in date span

Group By Provider:

Selected Providers:

Kevin's Clinic, Ryan White AIDS Care

and Treatment Clinic
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16. Below is an example report.

Client List

Data Scope: Kevin's Clinic, Ryan White AIDS Care and Treatment Clinic, State ADAP Program
Report Start Date: 01/01/2019

Report End Date: 12/31/2019

Report Criteria: Report Filter is empty
Restrictions: Clients with services only

Name: DOB: Gender: Race/Ethnicity:
Aaberg, Aaron, Morin 04/05/1992 Male Hispanic

Aadland, Abbey, 06/27M1975 Female More than one race
Aaland, Abdul, 08/08/1989 Male More than one race
Adap, Sigourney, 10/191991 Female Hispanic
Appleseed, Johnny, 12/05/1965 Male Hispanic

NOTE: Clients need to have at least one service visit during the date span

to be included in the report. If no date span was entered, you would get a
list of ALL your clients.
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Adding Report Filters

Now we will add some filters to the report.

1. Select Report Filter from the Custom Report menu (in this example, Client List is the name
of our custom report).

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List

Back
@Client List
Run Report Start I:_)ate : 061‘1_1]2018, End Date_: Dﬁ!11!2_019,_CIients with services, Report Display as :
Open in New Window, Most medical services in date span
Report Layout Client List, Demographics
Field Selection Name, DOB, Gender, Race/Ethnicity
I Report Filter I Report Filter is empty

2. Click Add from the Action bar.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List > Report Filter
Manage Move Up Move Down Delete Templates Back Print or Export

Report Filter

Search: !

n
v
]

Operator Paren. Field Name s Not
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3. Select Gender from the Field Name column (use the search bar to narrow your results, if
desired). Click Use Field.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List > Report Filter > Add
Use Field | Back Print or Export

Report Fields

Search: ‘G ender |

Field Name Keywords Previous Field Nar Description
ADR Gender ADR Gender
n Gender Demographics Gender I |

4. Enter in the desired criterion. In this example, we are filtering for clients who identify as
Male. Click Save.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List » Report Filter > Add > Criterion Details

Back
Use Field

Field Name: |Gender

IsNot: [J

I =: |Male BI

Null: [
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5. Click Back from the Report Filter screen to return to the Custom Report menu.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List> Report Filter
Manage Add Move Up Move Down Delete Templates Print or Export

Report Filter
Sean:h.'| |
Operator Paren. Field Name Is Not = >=

Gender Male

6. Select Run Report and then follow the steps on pages 9 through 11 (beginning with step
12). Once you run the report, you will now note that only “Male” clients are included.

CAREWare Reports » Custom Reports > Manage Run Custom Reports > Client List
Back

@Client List

o Start Date : 06/11/2018, End Date : 06/11/2019, Clients with services, Report Display as :
P QOpen in New Window, Most medical services in date span
Report Layout Client List, Demographics
Field Selection Name, DOB, Gender, Race/Ethnicity

Report Filter Gender = Male
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We will now use the AND / OR operators in our report criteria:

7. Follow steps 1 and 2 on page 13 to return to the Report Fields menu and search for the field
name “Race/Ethnicity.” Select the field name and click Use Field from the Action bar.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List > Report Filter > Add

Back Print or Export
Report Fields

Search: Race/Ethnicity

Field Name Keywords Previous Field Nar Description

l Race/Ethnicity Demographics Race/Ethnicity I

8. Use the Operator field to choose between “And” or “Or.” The Paren field is used to define
additional report filter criteria within the parenthesis. In this example, we are using the “And”
operator and only filtering for clients whose race/ethnicity is Black or African-American (the
selection is made from the drop down list within the “=" field). The first “open” Paren field
denotes that the race/ethnicity must be Black or African American. Click Save.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List > Report Filter > Add > Criterion Details

Save Back

Use Field

Operator: |AND B

Paren.: |

Field Name: |Race/Ethnicity
Is Not:
I =: |Black or African-American BI

Null:

Paren.:
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9. Repeat the previous step except this time, use the “Or” operator and include clients whose
race/ethnicity is Hispanic. This time, the second “closed” Paren field (while using the “Or”
operator) denotes that the race/ethnicity could be Hispanic.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List >

Save Cancel
Edit

Operator: |OR B

Paren.:

Field Name: |Race/Ethnicity

Is Not:

=: Hispanic E

The Client List criteria are listed next to the Report Filter in the Link Summary. For the client to
be listed on the report, they would need to be Male AND Black/African American OR Hispanic.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List
Back

@Client List

Start Date : 01/01/2019, End Date : 12/31/2019, Clients with services, Report Display as :

AR Open in New Window, Most medical services in date span
Report Layout Client List, Demographics
Field Selection Name, DOB, Gender, Race/Ethnicity

Gender = Male AND Race/Ethnicity = Black or African-American OR Race/Ethnicity = I

Report Filter I Hispanic
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In addition to the other report parameters and restrictions, they would also need to have
received a service in the 2019 reporting year (calendar year).

Client List

Data Scope:
Report Start Date:
Report End Date:
Report Criteria:

Restrictions:

Name:

Aaberg, Aaron, Morin
Appleseed, Johnny,
Cesar, Rex,

Fish, Blue.

Ghost, Caspar,
Kranepool, Bob,

Smith, Dominic,

Kevin's Clinic, Ryan White AIDS Care and Treatment Clinic, State ADAP Program

01/01/2019
12/31/2019

Gender = Male AND Race/Ethnicity = Black or African-American OR Race/Ethnicity
= Hispanic

Clients with services only

DOB: Gender: Race/Ethnicity:
04/05/1992 Male Black or African-American
12/05/1965 Male Hispanic

06/30/1987 Male Hispanic

04/12/11950 Male Hispanic

11/19/1974 Male Hispanic

1212111955 Male Hispanic

01/01/1950 Male Black or African-American
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Using Totals

NOTE: The following sections assume you are now comfortable creating field selections and
filters. We will show you what your field selections and filters should look like, but we’ll now skip
walking through each step to create them.

If you need to sum certain values or group the report in a specific way (e.g. over clients or
service categories), you can check the Use Totals on the Report Layout link. Use Totals also
includes functions to calculate the minimum or maximum or average of a group of observations,
such as CD4 or Viral Load counts.

We’'ll do two examples of the Use Totals function, one for a custom service report where there
are often multiple services per client, and one for a custom lab report, where there are often
multiple lab tests per individual.

Service Report (with totals)

1. Here is the top portion of a basic custom service report (fields “Name,” “Srv Category,” and
“Srv Long Name”) sorted in “Ascending” order by client.

Client Services

Data Scope: Kevin's Clinic, Ryan White AIDS Care and Treatment Clinic, State ADAP Program

Report Start Date: 01/01/2019

Report End Date: 12/31/2019

Report Criteria: Report Filter is empty

Restrictions: Clients with services only

MName: Srv Category: Srv Long Name:
Aaberg, Aaron Morin Oral Health Care Oral Health Care
Aadland, Abbey Medical Case Management MCM Non Face-to-face
Aadland, Abbey Medical Case Management MCM Face-to-face
Aaland, Abdul Medical Case Management Medical Case Management
Adap, Sigourney Medical Case Management Assassment/CMF
Appleseed, Johnny Medical Case Management MCM Non Face-to-face
Appleseed, Johnny Medical Case Management MCM Face-to-face
Appleseed, Johnny Early Intervention Services EIS Outreach
Appleseed, Johnny Early Intervention Services EIS Outreach

Appleseed, Johnny

Early Intervention Services EIS Outreach

You can see that some clients appear multiple times on the report, because they’ve received
multiple services in the date range.
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2. Select Report Layout from the Custom Report menu (in this example, Client Services is the
name of our custom report).

CAREWare Reports > Custom Reports > Manage Run Custom Reports = Client Services
Back

@Client Services

Start Date : 01/01/2019, End Date : 12/31/2019, Clients with services, Sum Numeric Totals,

Run Report Display Specifications, Report Display as : Open in New Window, Most medical services in
date span
| Report Layout | Client Services, Service
Field Selection Name, Srv Category, Srv Long Name

Report Filter Report Filter is empty
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3. Click Edit (will be where Save is in the below screenshot) and then check the Use Totals

box. Click Save

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client Services > Report Layout = Edit

Save | Cancel

Edit

Report Name:
Report Type:
|s Crosstab:

Description:

Read Only:

Layout Details

|F.‘,Iie nt Services |

|Service |

(]

I Use Totals:

J
a

Font Name:

Bold:

Italic:
Underline:
Font Size:

Color:

Header/Footer Format

\Arial

i O 0D

Black [ ]
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4.

Click on the Field Selection Link.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client Services
Back

®Client Services

Start Date : 01/01/2019, End Date : 12/31/2019, Clients with services, Sum Numeric Totals,

Run Report Display Specifications, Report Display as : Open in New Window, Most medical services in
date span
Report Layout Client Services, Service
l Field Selection I Name, Srv Category, Srv Long Name
Report Filter Report Filter is empty

Highlight the Field Name (in this example, Srv Long Name) and click Manage from the
Action bar.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client Services > Field Selection

Add MoveUp Move Down Delete Templates Back Print or Export
Field Selection

Search: ‘

Field Name Column Header Column Width (in) Totals Sort Sort Priority Status
Name Name 1.44 Group By Ascending 1 Complete
Srv Category Srv Category 1.80 Group By 0 Complete

I Srv Long Name Srv Long Name 1.80 Group By I 0 Complete
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6. Click View Select Field.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client Services > Field Selection > Srv Long Name

Back

®Srv Long Name

I View Select Field I Srv Long Name; Service; Service name

7. Click Edit (will be where Save is in the below screenshot) and then change the Total field,
from Group By to Count in the drop-down box. Click Save.

CAREWare Reports » Custom Reports > Manage Run Custom Reports = Client Services > Field Selection > Srv Long Name > View = View

Save § Cancel

View

Select Field: [Srv Long Name

Column Header: |Scy Long Mame

Total: |Count !!
Sort: I!

Sort Priority: |0 |

Header Column Format

Column Width: |1.8 | inches

Column Header Font Name:

|Ar|a|

Bold: [
talic: [

Underline: [

Font Size:

Font Color: |Black n

Data Column Format

Font Name: |Arial n

Bold: [
Italic: [
Underline: [

Font Size:

Font Color: |Bla|:k

Field Justification: |Left
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8. Return to the Custom Report menu by clicking Back twice or clicking on the report’s name
within the Breadcrumb links.

CAREWare Reports > Custom Reports > Manage Run Custom Reports =Q Client Services f Field Selection = Srv Long Name

®Srv Long Name

View Select Field Srv Long Name; Service; Service name

9. Re-run the “Client Services” report.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client Services
Back

@Client Services

Start Date : 01/01/2019, End Date : 12/31/2019, Clients with services, Sum Numeric Totals,
Run Report Display Specifications, Report Display as : Open in New Window, Most medical services in
date span
Report Layout Client Services, Service
Field Selection Name, Srv Category, Srv Long Name

Report Filter Report Filter is empty
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The report now returns the total subservices a client receives within a service category. Notice
for the client Abbey Aadland, there is now only one line for Medical Case Management, with the
number 2 in the Srv Long Name column, indicating how many of those services were received
in the date span.

Client Services

Data Scope: Kevin's Clinic, Ryan White AIDS Care and Treatment Clinic, State ADAP Program
Report Start Date: 01/01/2019
Report End Date: 12/31/2019
Report Criteria: Report Filter is empty
Restrictions: Clients with services only
Name: Srv Category: Srv Long Name:
Aaberg, Aaron Morin Oral Health Care 1
I Aadland, Abbey Medical Case Management 2 I
Aaland, Abdul Medical Case Management 1
Adap, Sigourney Medical Case Management 1
Appleseed, Johnny Early Intervention Services 3

Appleseed, Johnny Medical Case Management

Lab Report (with totals)

1. Here is the Field Selection setup of a basic custom report (fields “Name”, “Lab Result”),
sorted “Ascending” by client.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client CD4 Count > Field Selection

Manage Add MoveUp Move Down Delete Templates Back Print or Export

Field Selection

Search:
Field Name Column Header Column Width (in) Totals Sort Sort Priority Status
Name Name 1.44 Group By Ascending 1 Complete

Lab Result Lab Result 0.70 Group By 0 Complete
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2. Change the Total field in the Field Name “Lab Result” from Group By to Min in the drop-

down box.

CAREWare Reports > Custom Reports > Manage Run Custom Reports = Client CD4 Count > Field Selection = Lab Result > View > View

Save Cancel

View
Select Field:

Column Header:

Total:
Sort:

Sort Priority:

Column Width:
Column Header Font Name:

Bold:

Italic:
Underline:
Font Size:

Font Color:

Font Name:
Bold:

Italic:
Underline:
Font Size:
Font Color:

Field Justification:

Lab Result

Page |26

Lab Result

[Group By|
Average

[]
|

Count

Group By
Max

Min

Std Deviation

thes

Std Deviation Pop
Sum
Variance |

Variance Pop

3

I 0o o

Black

|Leit
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3. Below is an example of the “Client CD4 Count” custom lab report with Min total used.

Client CD4 Count

Data Scope: Kevin's Clinic, Ryan White AIDS Care and Treatment Clinic, State ADAP Program
Report Start Date: 01/01/2019

Report End Date: 12/31/2019

Report Criteria: Report Filter is empty
Restrictions: Clients with services only
Name: Lab Result:

Appleseed, Johnny 300

Beagle, Barney J 1

Brown, Buster j 45

Cesar, Rex 221

Client, Matalia S 900
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Using Calculated Objects in Custom Reports

The ability to analyze changes in lab results and other indicators is available with the addition of
calculated objects fields in CAREWare.

Using calculated objects will allow you to determine:

e The highest and lowest quantitative lab value within a specified date range

e The change in lab values from one period to the next (e.g., how much did a client's CD4
count or viral load increase or decrease?)

e The first medical service after HIV diagnosis with a specified date range

Setting up date ranges for comparison
Say you want to look at how long your clients have been receiving services.

There is a calculated object field that will look at the first service date and compare that to the
last service date and calculate the difference between them.

In custom demographic reports, we select one of the calculated objects as one of our report
fields.

1. Add a new custom Demographic report (see Creating an advanced custom report on page
2). We have named the report “Client Length of Care” in this example.

2. Use the following Field Names within the Field Selection menu: “Name,” “1st Overall
Service,” “Last Service,” and “Date Diff.” For a refresher on how to access the Field
Selection menu and how to add fields, please see page 5 through 8.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client Length of Care > Field Selection

Manage Add MoveUp Move Down Delete Templates Back Print or Export

Field Selection

Search:

Field Name Column Header  Column Width (in) Totals Sort Sort Priority Status

Name Name 1.44 Ascending 1 Complete
1st Overall Service j§ 1st Overall Service 0.80 0 Complete
Last Service Last Service 1.08 0 Complete
Date Diff Date Diff 0.80 0 Complete
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3. When adding the “Date Diff” field, use the following parameters:
1. DateColumn = 75! Overall Service from the drop-down box
2. DateColumn = Last Service from the drop-down box

3. Diff Type = Months from the drop-down box

4. Cross-Provider = No from the drop-down box

CAREWare Reports » Custom Reports > Manage Run Custom Reports > Client Length of Care > Field Selection > Date Diff > Subfilter
Edit Back Help

Subfilter

The following 4 criteria need completion for the subfilter

1. DateColumn

- |1st Overall Service

2. DateColumn

=: |Last Service

3. Diff Type

=: Months

4. Cross-Provider

=: No

NOTE: Select “No” for the Cross-Provider Subfilter when running a report
for a single provider. Select “Yes” to run a report for multiple providers and
if there are multiple provider domains configured in CAREWare.
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4. Return to the Custom Report menu by clicking the name of the report in the breadcrumb link
and click the Run Report Link.

CAREWare Reports > Custom Reports > Manage Run Custom Reports >I Client Length of Carel
Back

@Client Length of Care

Start Date : 01/01/2019, End Date : 12/31/2019, Clients with services, Sum Numeric Totals,
Run Report Display Specifications, Report Display as : Open in New Window, Most medical services in
date span

Report Layout Client Length of Care, Demographics

Field Selection Name, 1st Overall Service, Last Service, Date Diff

Report Filter Report Filter is empty
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5. Click Selected Providers from the Action bar.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client List> Run Report

Edit I Selected Providersl Ru

Run Report

Date From

Date Through

Clinical Review Year:

Output Display

n Report Back

Parameters
. 11172019 -
. [12/31/2019 -

2019

s |Open in New Window |

Show New Clients only:

Show Clients with Service only:
Show Specifications:
Sum Numeric Fields:

Primary Provider:

v

o

o

Most medical services in date span

Group By Provider:

Selected Providers:

Page |31

Provider Selection is required to run custom reports
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6. Select the desired providers using the checkbox. Once complete, click Save.

Page |32

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Client Length of Care > Run Report > Selected Providers

Select All  Clear Selection Cancel  Print or Export
Selected Providers

Search:

Select Provider Name

AIDS R Us

California Domain

Default

Jeff's Super Domain

Johns AIDS Services

Kevin's Clinic

I - Ryan White AIDS Care and Treatment Clinic I

State ADAP Program

7. Run the “Client Length of Care” custom demographic report (see step 15 on page 11). An
example of the results are found below.

Client Length of Care

Data Scope:
Report Start Date:
Report End Date:
Report Criteria:

Restrictions:

Name:

Adap, Sigourney
Appleseed, Johnny
Appleseed, Martha
Badland, Abbey
Baker, Clam

Brown, Buster

Ryan White AIDS Care and Treatment Clinic
01/01/2019

12/31/2019

Report Filter is empty

Clients with services only

1st Overall Last Service: Date Diff:
Service:

10/02/2012 04/10/2019 78
01/30/2019 04/08/2019 3
04/01/2019 04/01/2019 0
11/13/2018 02/11/2019 3
09/25/2012 03/01/2019 78

09/27/2018 01/24/2019 4
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Now looking at the same report, we will select multiple providers (see step #6), and change the
Cross-Provider Subfilter to “Yes” (see step #3). Below are the results.

Client Length of Care

Data Scope: Kevin's Clinic, Ryan White AIDS Care and Treatment Clinic
Report Start Date: 01/01/2019
Report End Date: 12/31/2019
Report Criteria: Report Filter is empty
Restrictions: Clients with services only
Name: 1st Overall Last Service: Date Diff:
Service:

Aaberg, Aaron Morin 01/01/2013 05/31/2019 76
Aaland, Abdul 11/01/2014 01/26/2019 50
Adap, Sigourney 10/02/2012 04/10/2019 78
Appleseed, Johnny 01/30/2019 04/08/2019 3

I Appleseed, Martha 05/06/2014 04/01/2019 59 I
Badland, Abbey 11/01/2014 05/15/2019 54
Baker, Clam 09/25/2012 03/01/2019 78
Ball, Abigail 11/17/2014 05/31/2019 54
Ball, Wrecking 05/23/2019 05/23/2019 0
Brown, Buster 09/27/2018 01/24/2019 4

The number of months elapsed between the first and last service dates, with Cross-Provider
Subfilter, set to “Yes”, and multiple provider names selected, changes the report results.

Notice there are additional clients in the report and the number in the Date Diff column for client
Martha Appleseed changed from 0 (in the previous single-provider report) to 59 months of care.

Other similar reports can be configured, such as the length of time between a client’s First
Service and First Medical Visit, or the length of time between a client’s Enrollment Date and
First Medical Visit or Lab result.

For further information, please see the Creating Custom Reports section of the jProg website:
https://www.jprog.com/wiki/CAREWare%206.UG-Creating-Custom-Reports.ashx
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